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This guide is intended to help you begin to use JMP, a basic statistics package,

and apprise you of its general capabilities and limitations.  This manual assumes that you

are familiar with operating a  Macintosh computer.   Its purpose is not to explain the

meaning of statistical tests and terms.  Before attempting to use JMP you must decide

what you need to do with your data and what results you would like to see.  This manual

takes you from that point and teaches you how to get the information you seek from JMP.

Please refer to your textbook or professor for a detailed understanding of the statistics and

probability involved in your project.

GETTING STARTED

To use JMP and create a new file, double click on the JMP icon and select New

from the File menu.   To open a sample datafile or any other JMP datafile just double

click on the icon.  This automatically opens the JMP application as well as the datafile.
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JMP looks like a spreadsheet.   In order to use it, you must first fill the columns

with your data.  Then you must ask JMP to analyze the data according to specifications

that will yield the results you desire.  When you create a new file, one column will

automatically appear.  You can begin putting data in that column by highlighting the first

block and typing in a piece of information.  Hit the tab key to move to the next row.

Additional columns can be created and deleted by selecting from the Cols menu.  Please

note that you MUST create additional columns by using the command New Column.  You

cannot just finish a column, move the cursor to the next column, and continue typing  as

you would with a normal spreadsheet.

Use the tab and return keys to move around the spreadsheet.   Information can be

changed by highlighting the data you want to replace and typing in the new data.  There

is a command to add new rows under the Rows menu.  Most of the commands needed to

input your data are self-explanatory.

The most complicated thing about JMP is that it requires you to properly define

what type of data appears in each column.  For example, immediately above the title of

the column is a little box with letters in it. 

 
If you click on it you will see that three choices appear, interval, ordinal, or nominal.

Every column you use must be defined as interval, ordinal, or nominal and these are

known as data types.  The meaning of these terms will be explained later in this section.

You can change the data type of a column by using the pop-up menu above the title of the

column.

When ever you create a new column, you have to specify its Data Type as well as

its Measurement Level, Format, and Formula status.   You can always change the

specifications of a column by either choosing Column Info from the Cols menu or by

double clicking on the white area above the name of a column.

You must choose if the Data Type is interval, ordinal, or nominal, and also if the

Measurement Level is character, numeric, or row state.  These choices are extremely

important because the way that you define your data determines the types of analyses that

JMP performs for you. Format refers to the appearance of the data; namely, how many
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decimal places, if any, do you want.  Best means JMP looks at the data and decides what

is best.  By choosing Decimal you specify a certain number of decimal places.  Date

means that the data is composed of dates.  The Formula box lets you choose to use the

calculator option and specify a formula to compute the values of the column.   For

example, this lets you create a Column called "Total Scores" that is composed of the sum

of two other columns, Verbal SAT Scores and Math SAT Scores.

STEP ONE - DEFINING DATA TYPE AND MEASUREMENT LEVEL

The first thing to remember about defining your data is that you can easily

reclassify it at any time by clicking on Col Info or in the box above the title of the

column.  If fact, you will probably want to experiment with the different possibilities for

graphs, summaries, etc. by doing exactly that.  Change a column from interval to ordinal

or nominal and re-draw histograms and see how the information that accompanies the

graph changes.

Here is a quick summary of what the different terms mean.

Data Types:

A)  Numeric - numbers only, with or without a decimal point.  Numeric data can

be assigned interval, ordinal, and nominal measurement levels.

B)  Character - can be numbers or non-numeric data (e.g. words).  The numbers

act like labels; JMP does not use them in mathematical computations.

C)  Row State - for now, ignore this option.  The meaning of Row State data will

be explained later in this manual under the section Markers.

The basic rule is to choose between numeric and character.  If you are using

words, choose character.  If you are using numbers and you want the computer to treat

them like numbers, choose numeric.  If you are using numbers that represent something

to you or your study other than their usual numerical value, choose character.  If you are

inconsistent, JMP will tell you and ask you to change the Data Type of a column if you

try to assign a measurement level that is unacceptable.

Measurement Levels:

A)  Interval (numeric measurements) - You can only designate a column as

interval if it contains numeric data.  Numbers have both order and magnitude, meaning

they can be used to order data and/or they can be used for their magnitude.  When you



JMP - Intro User's Guide

4

designate data as interval, the computer uses the numbers for their real magnitude.  For

example, the numbers 1, 2, 3 when used for order or rank just show that 3 is larger than 2

which is larger than 1.  When used for its magnitude, the computer treats the number "3"

as a real number and uses it in computations.  In sum, JMP treats your data as real

numbers in computations and uses their values directly.

B)  Ordinal  (means ordered in some way) - Can be either numeric or character

type data.  JMP treats ordinal columns as discrete categorical values that have an order.  It

alphabetizes words or letters and arranges numbers by numerical sequence.  In sum, it

uses numbers for their order, not their magnitude.

C)  Nominal  (classifications for letters or numbers) - Can be either numeric or

character data types.  All values are treated as being discrete with no order.  You are

basically using this data to give something a name or classification.

This may sound rather confusing, and it many ways it is.  The good news is that

the semantics themselves don't matter that much and you will quickly become used to the

idiosyncrasies of JMP.  What is important is that you know which measurement levels to

assign to your data in order to do regression analysis or find correlations, etc.  This guide

includes a table that lists most of the important capabilities of JMP and how to define

your data in order to do the analyses you desire.  Remember that no choice you make is

set in stone and you can always change data types and measurement levels.

STEP TWO - ANALYZING DATA

JMP gives you a choice of ways to analyze data under the Analyze menu.  The

table that appears below this section gives examples of which options yield which results,

charts, and information.  In general, the choices are rather self-explanatory.  To analyze

one sample at a time, choose Distribution of Ys.   This will give you the standard one-

sample descriptive statistics (histogram, mean, Std, quantiles, etc.) as well as one-sample

hypothesis tests.  Almost all of the more complicated data models can be found by using

the analysis option, Fit Y by X .   Fit Y by X does regression, logistic regression, the two

sample t-test, and contingency table analysis.  Depending on the measurement level you

assign to your data, JMP will carry out different types of analysis.  When you choose Fit

Y by X, JMP chooses tests relevant to the measurement level of the data.  You can see this

most easily by studying the following chart.  For multiple regression, choose Fit Y by X's.
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CAPABILITIES OF Fit Y by X DEPENDING ON THE MEASUREMENT LEVEL

          X                                             X

               INTERVAL                NOMINAL/ORDINAL

                    Y

           INTERVAL

Regression/Correlation

Two Sample (t-test)

 or

K-Sample Data (Anova)

(Anova is not explained in this

manual)

                    Y

       NOMINAL/ORDINAL Logistic Regression

(not explained in this manual)

Contingency Table and

Chi-Square Test

 DEFINING YOUR VARIABLES

In order to analyze any of your data, you must first select independent and

dependent variables.  There are three ways to choose X and Y variables.

1)  You can choose from the pop-up menu in top box above the title of the

column.

2)  You can click on the type of analysis you desire and then choose X and

Y variables from the box that appears on the screen and prompts a 

choice.

3)  You can choose Assign Roles from the Cols menu.

X - identifies the information in a column as independent variables.

Y - identifies the information in a column as dependent variables.

Weight - identifies a column whose values supply weights for each Y variable.

Freq - identifies a column whose values assign a frequency to each row for 

analysis.

Label - identifies a column whose values serve merely as labels for information in

other columns.
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QUICK REFERENCE TABLE FOR ANALYZING DATA

The following is a table that should be of use to you in determining what

measurement level to assign your data and which analysis to choose.

DESIRED RESULTS: ROLE MEASUREMENT

LEVEL

ANALYSIS

TO ANALYZE ONE SAMPLE AT A TIME:

histogram

max, min, media, quartiles (Quantiles)

mean, Std, N count (Moments)

t-test (pop-up menu next to title above
           histogram under Test Mean=value)

Y INTERVAL DISTRIBUTION OF Y's

ANALYZING ONE SAMPLE AT A TIME

histogram/stacked bar chart

counts, proportions (Profile)

Y NOMINAL/ ORDINAL DISTRIBUTION OF Y's

CORRELATION/REGRESSION

scatter plot

regression line (pop-up menu under Fitting -
      Fit Line)

mean line (pop-up menu under Fitting - Fit
     Mean)

correlation (pop-up menu under Fitting - you
     must choose any Density Ellipse)

confidence curves (options under pop-up
     menus for each fit)

Std, mean (text under Bivariate which
       appears after you fit a Density Ellipse)

R Square (Sum of Fit)

slope and intercept (Parameter Estimates)

Y

X

INTERVAL

INTERVAL

FIT Y BY X
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COMPARING TWO SAMPLES

side-by-side plot

mean, Std (Fit Means from pop-menu under
      scatter plot)

side-by-side box plot (Fit Quantiles from pop-
     up menu under scatter plot)

two sample t-test or Student's t (Compare
each Pair from pop-up menu under scatter
plot)

Y

X

INTERVAL

NOMINAL/ORDINAL

FIT Y BY X

CONTINGENCY TABLE

stacked bar chart

Pearson's Chi-Square test (Analysis of
     LogLikelihood, last line)

counts for each variable (Response Counts)

proportions for each variable (Response
    Profiles)

Y

X

NOMINAL/ORDINAL

NOMINAL/ORDINAL

FIT Y BY X

MULTIPLE REGRESSION

R Square (Summary of Fit)

estimates for a formula (Parameter Estimates)

to plot this three variables, go to Analyze
     menu and choose Spin.

Y

X

X

INTERVAL

INTERVAL

INTERVAL

FIT Y BY X's

HOW TO MAKE YOUR HISTOGRAM HORIZONTAL INSTEAD OF VERTICAL

If seeing your histograms and bar charts vertical annoys you and you would prefer to

see them horizontal, here is how to fix the problem.  Look in the pop-up menu at the check

mark at the lower left hand corner of the window.  There you should find an option called

Horizontal Layout.  When you choose this, a check mark appears next to the words

Horizontal Layout and everything in the window changes to a horizontal display.  You can

revert back to a vertical display by turning off Horizontal Layout.  Just choose it again from

the pop-up menu and the check mark will disappear.

SAVING YOUR DATA

In order to save your spreadsheet, use the Save command under the File menu as

you would for any other Macintosh program.  To save graphs and analyses, use the $
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menu in the lower left hand corner of each window to save the information you have

generated.

HOW TO STOP JMP IF YOU MAKE A MISTAKE

In case you make a goof and need to interrupt a JMP analysis process, try

Command period (hitting the apple key and the period at the same time).  This should

abort any process.

EXAMPLES:

I.  TRYING OUT JMP

A.  How to make a histogram

Begin by opening the file in SAMPLE DATA called GOLF BALLS.  You should

find a spreadsheet with three columns, Brand (nom), Distance (int), and Durability (int).

Go to the Analyze menu and choose Distribution of Y's.  Click on Brand and then click on

Add to move it into the box on the right.  Do this for Distance and Durability so that all

three appear in the box on the right. Click on Done.  This tells JMP to draw histograms

for each of the three columns and to analyze the results one sample at a time.

JMP will draw histograms for each of the three variables and provide either

Summaries and Profiles or Quantiles and Moments, depending on the measurement level

of the column.  Click on the word Summary and watch the information in its box

disappear.  Click on Summary again and watch the text reappear.  This is an option for all

JMP windows.  Move the cursor to the column name above the histogram for Distance

and click on the bold half-triangle to view a pop-up menu.  Choose Test Dist =Mean and

type in a hypothetical mean.  JMP will run a t-test for you and display the results.  Note
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that a t-test is an option only for data that is interval.  Ask your professor to explain the

meaning of the information provided by JMP or consult a textbook.

B.  Simple Regression

Let's try simple regression analysis using JMP.  Begin by opening the file in

SAMPLE DATA called STUDENTS.  You should find a spreadsheet with five columns,

age, sex, height, weight, idnum.  From the analysis menu, choose Fit Y by X.  Assign

Height to be the Y variable and Weight to be the X variable.  JMP draws a scatter plot for

you and gives you the option to fit a regression line as well as polynomials, splines, and

density ellipses.  From the pop-up menu that appears next to the word Fitting, choose Fit

Mean and Fit Line (this is a regression line).  Take a look at the lines that now appear on

the scatter plot.  For additional details, click on the words Mean Fit and Linear Fit for

more text displays.  To find the CORRELATION between the two variables, choose

Density Ellipses from the Fitting menu and pick any value.  An ellipse will appear on the

scatter plot and the word Bivariate will appear under the scatter plot.  As described

above, click on the word Bivariate to see additional text details, including the correlation.

You can find the slope and intercept for the regression line in the text under the

Parameter Estimates box.  The best way to learn the capabilities of JMP is to experiment

with it by trying different fits and observing the results.
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C.  Two-Sample Tests (t-test)

 Open the file called STUDENTS in the SAMPLE DATA file.  Go to the Analyze

menu and choose Fit X by Y.  Assign sex as the X variable and weight as the Y variable.

This is extremely important because JMP will only perform this test if X is nominal or

ordinal and Y is interval.  You should see a side-by-side plot and a half-triangle with a

pop-up menu below the plot.  In order to run a two-sample test, choose Compare Each

Pair from the pop-up menu.  The display should look like the example below.  The

results of the t-test appear when you click on the Means Comparisons box.
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II.  USING THE CALCULATOR - How to make a new column that is the difference of

two other existing columns

Begin by opening the file in SAMPLE DATA called FITNESS.  Suppose you

would like to know the difference for each row between the resting pulse and the pulse

after running.  Go to the Cols menu and choose New Column.  Change the Data Source

from No Formula to Formula , re-name the column Differences, and click on OK.
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Now you are in the calculator mode.  The rectangular box at the bottom of the

screen is where you can create formulas.  Make sure that the small box is highlighted.  If

it is not, click on it to highlight it.  Click on RunPulse in the box in the upper left hand

corner.  Next click on the minus sign and last click on RstPulse.  If you make a mistake,

highlight the whole formula you have created and hit the delete button on the keyboard.

Close the window and JMP will compute the new values for the column.

This same technique can be used to create simple formulas to compute new

columns.  The best way to learn to use the calculator is to spend a few minutes playing

around with the different options.  Here are a few hints about the calculator and formula

columns in general.

a.  If you want to insert a number into a formula, first locate the box underneath

the constant key on the calculator.  Click on the arrows until the title of the box reads

numeric.   Type the number you want to insert in the formula in the box.  While the

number is highlighted, click on the constant key which will insert the number into your

formula.  If you need to insert a number in quotes like "0", follow this same procedure,

except change the title of the box from numeric to character.

b.  If you need to change the formula of a column or if you just want to view the

formula box, either choose Col Info from the Cols menu or double click on the top of the
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column next to the small box that designates the role (X, Y, etc.)  When a new screen

appears with information about the column, double click on the formula that appears in

the lower right hand corner.  The calculator should appear.

III.  SIMULATIONS - How to simulate tossing a coin with JMP

In order to simulate tossing a coin, we will write a short formula to make JMP

generate a list of uniform random numbers (this means that the numbers all lie between 0

and 1) and then assign values of 0 or 1 to the numbers depending upon their values.  This

simulation will be for a fair coin, so the chance of getting a head ( "1") or a tail ("0") is

equal.  The "0"s and "1"s act as labels to signify heads or tails so we designate the column

as character.

Step 1 - Choose New Column from the Cols menu.  Format the new column to be

of character data type and of nominal measurement level.  Also choose Formula rather

than No Formula.  Click on OK.

Step 2 - Now you should be in the calculator mode.  Begin by clicking on

Conditions in the function box in the upper right hand corner and then click on the word

If that appears in the Conditions menu.  In the calculator, the box following the word If

should be highlighted.  If it is not, highlight it.

Step 3- Go back up to the function menu and click on Comparisons.  Click on

x>y.  In the calculator, highlight the box following If.  Click on Random in the function

box.  When the Random menu appears, click on Uniform.  The box following If should

now read ?Uniform.

Step 4- Now highlight the box following the > sign.  Go to the box below the

word constant,  and make the title read numeric.  Type in .5 and then click on the

constant key in order to insert the number into the box in the calculator.

Step 5 - There should only be two empty boxes left in the calculator.  Highlight

the box preceding If.  Go back to the box below the constant key, but now change the title

to character.  Type a 0 in the box  (it should appear in quotes), and click on the constant

key to insert "0" into the box in the calculator.  Repeat this procedure for the last box to

fill it with "1".  The final formula should read:
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Step 6 - Close the window to return to the spreadsheet.  By adding rows (Rows

menu), you can simulate as many tosses of a coin as you desire.  Try making a histogram

of the trials and checking the mean and the number of heads and tails.  Is it what you

expected?  The more tosses, the closer the results should be to the expected value.

In order to simulate a biased coin, change the value in the clause  ?uniform > ___.

IV.  EXPONENTIAL DISTRIBUTION  - How to take the -log of random numbers

Sometimes you may need to generate random numbers that have distributions

other than a normal distribution.  For example, if you take the negative log of a series of

uniform random numbers, the distribution will be what we call exponential.  Here is an

example of how to do just that.

You should now be familiar with getting into the calculator mode.  Create a new

column that requires a formula.  Once you are in calculator mode, choose Random from

the functions menu.  Click on Uniform.  Next choose Transcendental from the functions

menu and Click on Natural Log.  Last, click on the +/- box of the calculator keypad to

make the whole statement negative.  The final formula should read:

Close the window and add rows until you get the amount of data you desire.

Draw a histogram and compare the shape of the distribution to a normal distribution.

V.  FINDING THE AREA UNDER THE NORMAL CURVE

 JMP also has the capability of serving as a statistical table for certain values.  It is

very simple to find areas under the normal curve.  To demonstrate practical use for this

computation, let's use the example of test scores.  Suppose that the mean on a certain test

is 80, the Std = 5, and you scored 88.  What percentage of people scored worse than you,

or in other words, in what percentile did you score?   Note that you are assuming that the

scores follow a normal distribution.

First calculate your score in Stds.  Do this by subtracting the mean from your

score (88-80=8) and dividing that by the Std (8/5=1.6).  Now you can use JMP to find the

normal distribution of 1.6.
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Create a new column that requires a formula.  When you are in calculator mode,

click on Probability in the function menu and then on Normal Distribution.  In the

calculator box you should see the term normDist followed by an empty box in

parentheses.

Look at the box under the constant key on the calculator keypad.  If it does not

read numeric, click on the arrows at the side of the box until it does.  Enter 1.6 in the box,

and click on the constant key to insert it into the formula.

When you close the window JMP will fill all the rows in the new column with the same

value (slightly inconvenient, but unavoidable.  If it bothers you, delete all the rows but

one for that column).  The number that appears in the new column, .95,  gives you the

percentage under the normal curve that is equal to or less than 1.6.    This means that 95

percent of the students scored worse than you, or equivalently you scored in the 95th

percentile.

Also in the Probability menu in the function box is the Normal Quantile function,

the inverse of the Normal Distribution function.  This allows you to input a quantile, for

example .95, and JMP will calculate its corresponding point from the normal curve.  In

this case the response would be 1.6.

OTHER USEFUL OPTIONS IN JMP

This manual cannot detail all JMP functions, but it tries to introduce options that

may be of use in your projects.  Here are a few tricks that might come in handy.

A.  Grouping

JMP lets you group together information so that you can easily view

breakdowns by type, size, company, etc. in the summary tables of analyses.  For example,

what if you are trying to evaluate different kinds and sizes of personal computers by how

easy they are to use and how much they cost.  By clicking on Group/Summary from the
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Tables menu, you can choose what columns you would like to group together.

Experiment with this option to get the desired results.

B.  Markers

JMP allows you to mark individual pieces of data with markers so that you

can point out outliers, extremes, etc.  For example, let's say you are playing with two

columns, an X variable, and a Y variable, and you have drawn a scatter plot with Fit Y by

X analysis.  Suppose there are some outlying points and you would like to mark the rows

on the spreadsheet that correspond to these points.  Go to the Rows menu, choose

markers, and pick one of them.  For example, if you choose the x, any point that you

highlight in the scatter plot will be marked with an x.  You can highlight more than one

point by shift clicking.  When you return to the spreadsheet you will find that the outlying

points you marked are also marked with x's on corresponding rows on the spreadsheet.

To erase these markers, choose Clear Row States from the Rows menu.  Also note that if

you merely highlight any part of the scatter plot or other plot (not using markers), the

corresponding rows in the spreadsheet will also appear highlighted.

If you use markers to reveal information about certain rows in the spreadsheet,

you may want to save that information.  This is where the data type Row States comes

into play.  The markers are not part of any of the columns and they will not automatically

be saved when you save the spreadsheet.  Here is how to save your markers:

 Create a new column and define the data type to be Row States.  From a pop-up

menu at the top of the new column, choose Copy from Row State.   JMP will copy the

markers into the new column.  In practice, the column tells information about the "state"

of the rows.

C.  Subsets

With JMP you can create a new spreadsheet made up of a subset of only

data you have selected.  For example, you might make a new spreadsheet of the data from

only the first 10 rows of the full data table or including only the outlying points on the

scatter plot.  In order to create a subset, simply highlight the rows you want to include in

the new data table, and then select Subset from the Tables menu.  On the screen a new

data table will appear.

WHAT JMP DOES NOT DO

Although JMP has good capabilities for most simple tests and models in

introductory statistics and probability, there are certain basic things it cannot do.  JMP

cannot do binomial distributions.  In fact, there is no option in the calculator for factorial.

The best you can do is to use the calculator to write a short formula to compute the
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factorials of the row numbers using the Product function in the Statistical  menu in the

function box.  You can get "i" (row #) from the Terms menu.  To get "j" you need to click

on Index from theStatistical menu.  The formula should look like this:

If you are really energetic, you can also use the calculator to write a short program

to compute CHOOSE (n, i) for i = the row numbers.  For example, if you have 5 rows in

a column, n=5 and i=1, 2, 3, 4, 5, JMP will calculate how many ways there are to choose

1, 2, 3, 4, and 5 from a set of 5.  The formula should look like this:

AN EASIER WAY TO DO SIMULATIONS  - Using a program called Data Desk

It is possible to do simulations, like tossing a coin for example, using JMP as is

described above under the section of this manual titled SIMULATIONS.  However, it is

time-consuming and a multi-step process.  If you need to do simulations, I recommend

that you use the student version of program Data Desk if it is available.

The Data Desk format is very different from that of JMP.  Instead of a spreadsheet

appearance, Data Desk generates a small window for each column you create.  If you put

them all together side-by-side and match up the rows, they resemble a spreadsheet.

In order to simulate tossing a coin, go to the Manip menu and choose Generate

Random Numbers.   The number of variables you ask the program to generate refers to

how many sets of data you want the computer to create.  The number of cases/variable

refers to the number of trials per variable.  For example, if you ask for 2 variables with

100 cases each, two icons will appear on the screen each containing a list of 100 numbers.
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Uniform random numbers lie between 0 and 1.  Their distribution is uniform, not

normal.

Normal generates random numbers with a normal distribution.  By default this

refers to a distribution with mean=0, centered at 0, Std=1.  You can choose µ (mu, the

mean) and σ(sigma, the Std) by filling in the blanks to choose a different normal

distribution.

Bernoulli trials generate a series of 0s and 1s which is useful for simulations like

tossing a coin.  You set the probability of getting a 1 which marks a success.  For

example, for a fair coin, p=.5.

Binomial experiments gives you the option of having the computer do a number of

Bernoulli trials per experiment and add up the successes.  You enter the probability of

success just as you would for a simple series of Bernoulli trials.  If you ask the computer

to "Generate 2 variables with 100 cases/variable" and to do "100 Bernoulli

trials/experiment," this is what will happen.  For each of your 100 cases, the computer

will do 100 experiments and sum the successes.  It will do that 100 times per variable and

you asked for 2 variables.  This is really (100*100) * 100  trials for each variable.

Poisson generates random numbers with a poisson distribution.  You must input

the value of λ (lamda).
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 TROUBLESHOOTING

If you have problems or questions, first try JMP Help.  You can get help by

choosing the ? from the tools menu and the clicking on graphs, plots, or tables to view

help windows.  If you still have questions, ask your professor for the JMP User's Guide

which is a 500 page manual and is certainly more detailed than this short guide.

However, it is also more complicated, so be forewarned.   If you or your professor have

questions that are not addressed in the official JMP guide, call the SAS Institute in Cary

NC at (919) 677-8000 and ask for a JMP consultant.  You need to give them the serial

number for your JMP package or server.  A consultant will research your question and try

to give you a response within 24 hours.
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